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Statement
Welcome to use the product from Xi’an NovaStar Tech Co., Ltd. (hereinafter referred to as
“NovasStar”). It is our great pleasure to offer this manual to help you understand and use the
product. We have striven for precision and reliability during the compilation of this manual, and
the content of this manual is subject to change without notice. If you have any problem in use or
you have any suggestion, please feel free to contact us according to the contact information
provided in this manual. We will do our utmost to satisfy your needs. We would like to express
our sincere thanks to your suggestions and make assessment for adoption as soon as possible.

Copyright © 2017 NovaStar

No part of this document may be copied, reproduced or extracted in any form or by any means

without the prior written consent of NovaStar. All rights reserved.

Trademarks

NOVASTAR gnd MIVASTET are registered trademarks owned by NovaStar.

All other trademarks, brand, product, service and company names mentioned in this document
may be trademarks, registered trademarks, trade names of their respective holders.
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1 Overview

SmartLCT is a new generation of LED display configuration software from NovaStar, in

conjunction with LED display controllers for smart configuration of various complex LED

displays, including building-block configuration, online/offline design, seam brightness

adjustment, cabinet rotation, etc., to provide an easy access for users to operate LED displays

and present you a perfect display.

Features

Building-block configuration: Configure LED displays by adding cabinets via online or offline
design and setting the position and physical connection of cabinets, which is easy to
operate and flexible to configure.

Seam brightness adjustment: Effectively solved the issue of brightness adjustment of seams
among cabinets or modules. Seam brightness adjustment supports single and multiple
selection to present you a perfect display.

Canvas exporting: Users can export edited physical connections of cabinets and data related
to devices in picture format.

Hot backup: Backup Ethernet ports and devices to make sure the LED display operates
normally when primary devices and Ethernet ports cannot work normally, which provides
users protection and effectiveness for LED display configuration.

Property settings of LED display controlling units including I/O source settings, color
settings, PIP, montage, etc.

Operating system: OS X, Windows 7 or above.

1.1 Configuration List

Name Version/Model Function Notes

SmartLCT | V3.0 Operating Platform Standard

3D HD, NovaPro HD

K4/K4S
LED Display VX2/VX4/VX4S Primary controllers of LED
Controll display and video processing Optional
ontroflers V700/V800/V900 units

MCTRL300/MCTRL500/MCTRLR5/
MCTRL600/MCTRL660/MCTRL4K
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MRV200/MRV210/MRV220/MRV30

. 0/MRV320/MRV330/MRV340/MRV ) )
Receiving 350/MRV360/MRV365 Display driver modules of LED

Cards display Optional

1.2 System Structure

LED Display Controller

SmartLCT LED Display

www.novastar.tech 2
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2 Software Installation

Just like the installation of other common software, install SmartLCT3.0 by following the setup

wizard.

In case of antivirus or firewall popups during installation, please
A permit them because serial driver may need to be installed
during program installation.

The installation program will update the serial driver on

(= customers’ computer to the version of the driver in the
installation package automatically if there is no serial driver or its
version is too low.

www.novastar.tech 3
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3 SMmartLCT Interface Introduction

3.1Login

7]

After SmartLCT is installed successfully, click on the icon 'Sssr| to access the start page, as

shown in the figure below.

SmartLCT V3.0

Function

Create offline design

[+ Create online design
Open

6 Language

O Eit

Recent
Project.srex

Project2.srox

Device list # Qv
USB@Port #0010.Hub_ #0001 WX45 lsets
Screen list &

Screenl 831%521

Create new online or offline projects, or open existing projects, then access the page of LED

display configuration, as shown in the figure below.

www.novastar.tech
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Menu Bar/Tool Bar

Icon

Function

Undo (Ctrl+2)

Back to last step

Redo (Ctrl+Y)

Cancel last step

«
/

Edit Grou All the cabinets will be edited or moved together after
P grouping.
Ungroup / Recover the grouped cabinets to single cabinets.
Zoom in ©F | Zoom in the view of the cabinets on the screen.
Zoom out El Zoom out the view of the cabinets on the screen.
1:1 / Display the cabinets with a scale of 1:1.
Zoom to fit II:I] Adjust the cabinets to a viewable size on the screen.
Select this option to show the status of the receiving
Online status / cards connected to the Ethernet ports of the device.
(Green denotes online while gray offline.)
Including “Sending card info”, “Port No.” and
“ HVH H ”»
. Cabinet info | Re§e|v1ng cz?rd info”. ' .
View The information of the option you selected will be
shown on the cabinets.
Select this option and the added cabinets will be
Auto connect / .
connected automatically.
Show grid | S'el'ect this option and the grid on screen area will be
visible.
Including “Snap to grid” and “Snap to cabinet edge”.
Sha | Select it, and when you moving a cabinet, the cabinet
P will snap to the border of its nearest grid or cabinet
automatically.
View Including “Front view” and “Back view” for changing

users’ view while looking at cabinet connections.

www.novastar.tech




SmartLCT User’s Manual

Operation
(Online)

Reconnect device

Reconnect all the devices.

Refresh device

Refresh device status information

Send

Send screen configuration information to
corresponding controllers.

Save to hardware

Save screen configuration information to hardware so
as to avoid information loss.

Hot backup

Backup devices and Ethernet ports.

Seam brightness
adiustment

Adjust brightness of the seams among cabinets.

Test patterns

Choose different screen test patterns.

Tools Calculator / Open the calculator of Windows.
User’s Manual / Get User’s Manual of this software.
Help
About / Check the information related to this software.
Language / / Switch Ul language between English and Chinese.
Delete lines #3 Delete the lines among cabinets.

www.novastar.tech
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4 Language Settings

SmartLCT supports two languages: English and Chinese. You can switch languages through
following two ways.
* (lick Language on the start page and an option box appears, then select the language you

want.

Function

Create offline design

[+ Create online design

Open Language Endglishi{en) ~
English
R (zh-cr)
o o L A

* Access the page of LED display configuration. Click Language on the menu bar and a drop-

down menu appears, then select the language you want.

File Edit View Operation Tools Help
v English{en)

S ) @ Q O ¥ (zh-cn)

www.novastar.tech 7
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5 Offline Operation

5.1 Creating Projects

Run the software. Create a new project of LED display configuration in offline state. Click Create

offline design on the page of Function to access the page of Create a new project.

1)
2)
3)
4)
5)

Customize the project name and select the save path of the project.

Select the device: Select the matched controller. Here we take MCTRL4K as an example.
Select the cabinet: Select LED display cabinet manufacturer and type.

Screen size: Set the number of columns and rows of cabinets.

Connection type: Choose the way to connect the cabinets.

1. Mame the project

Mame  Project

Path  |C:UsersiAdministrator/Documents
2 Selectthe devi |MCTRLRS
3. Selectthe cabinet Management
Manufacturer | 104

Type |304x152(30

4. Screen size

Function Cabinet columns = Cabinetrows 1

5. Connection type

Create offline design 7

[+ Create online design

= it 2 M S th & 4

Open

& Language

¢ Exit

%

5.1.1 Cabinet Management

@ Select& Export: Export the information of selected cabinets to files

(@ Export all: Export all the cabinet information to files

(@ Delete: Delete selected cabinets.
@® Add: Add new cabinets.
(® Edit: Edit selected cabinets.

www.novastar.tech 8
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F

(3 Manage cabinets @

Ll

¥ Defauit
F Defaultl

Cancel

5.1.2View Switching

* The page of Create a new project includes two views: “Normal” and “Smart”.
* It only needs to name the project, choose the save path and select the cabinet in “Normal”

view.

www.novastar.tech 9
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Create a new project

Mame Projectl|

FPath | ninistrator’Documents

2. Selectthe cahinet Management

P Default
P Defaultl

Srnart 0 Cancel

5.2 LED Display Configuration

As shown in the figure below, the page of LED display configuration appears after a new project
is created.

www.novastar.tech 10
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Create new projects or click existing projects to access the page of LED display configuration.

MCTRL4K-1
AL

Click on the selected device to expand the drop-down list of Ethernet ports. Use your mouse to

drag the scrollbar to view all ports.

Add devices

Click Add devices at the bottom of the device list to add new devices.

Add devices

MCTRL3I00
MCTRLS00
MCTRLEGD/E00
MCTRLAK

Mova3DHD

MavaProHD

Mumber

1

1

1

Selected devices

Fort name

Mumber

»  Click the device models you want to add in “Optional devices”. Double click on the field of

“Number” column in “Optional devices” to edit the number of cascaded devices.

www.novastar.tech
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» (lick Add button on the middle area after a device is selected to add the device to “Selected
devices”. Click OK after the device is added.

Device Properties

Select a cabinet on editing area and its properties are shown on property area. Here we take

MCTRL4K as an example.

Properties

Manufacturer  Default

Type  Default

Device MCTRLRS-1

Port name

Connection

Mapping position

Position

Rotation

Test patterns

“Properties” includes “Manufacturer”, “Type”, “Device”, “Port name”, “Connection”,
“Mapping position”, “Position” and “Test patterns”.

“Connection”: 1-2-3 denotes sending card No. 1, port No. 2, receiving card No. 3.

“Mapping position ”’: The position of the added cabinet on the screen.

“Position”: The position of the selected cabinet on the screen.

“Test patterns”: Choose the correspongding test pattern of the selected cabinet.

If devices with rotation function are connected, for example, MCTRLR5:

Added “Rotation” function: Select a single cabinet and set its ritation angles, then is enables the
rotation of a single cabinet. If many grouped cabinets are selected, set the rotation angle and all
the selected cabinets will be rotated together.

Propetties

Manufacturer Default
Type Defaul
Device MCTRLRS-1
Fort name

Connection

Mapping position X

Fosition

Rotation

www.novastar.tech 12
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5.2.2 Cabinet Configuration
Add cabinets
As shown in the figure below, click Add button on the tool bar to access the page of Manage

cabinets. Then click on to access the page of Edit added cabinet.
Edit cabinet information such as manufacturer and cabinet name on the page of Edit added

cabinets. After the information is edited, click Save and a new cabinet is created.

Manage cabinets IEI

2 @

P Default
b Defaultl

Edit added cabinets @I

Manufacturer |

Mame

«  From .refgxfile

‘idth Height

Cancel

Cancel

Edit Cabinets

Click Add button on the tool bar to access the page of Manage cabinets. Select the cabinet

to be edited and click Edit button to access the page of Edit added cabinet where cabinet
information can be edited. Click Save after finishing editing, as shown in the figure above.
Cabinet Connections

As shown in the figure below, choose a cabinet connection type on the tool bar. There are two

ways to connect cabinets.

www.novastar.tech 13



SmartLCT User’s Manual

I. Auto
View>Auto connect

File Edit | “iew! Tools Help AE

Click View on the menu bar and select “Auto connect” on the

drop-down menu that appears. Select the matched device and ports from the device list at the

left side of the page. Then click Cabinet button, hold and drag it into editing area, and
you can click on the editing area repeatedly to add more cabinets. Right click on your mouse to
cancel adding cabinets, then connection lines among the added cabinets will appear
automatically (or hold and drag the mouse on the editing area to add more cabinets continually
and connection lines among the added cabinets appear automatically, then right click on your
mouse to cancel adding cabinets.).

Note:

The connection order is based on the adding order. You can select all the cabinets and select a

connection type on the tool bar to change the connection of the cabinets.

90%

Add cabinets

www.novastar.tech 14
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Select cabinets

Select new connection type

II. Manual

File Edit |%iew Toolz Help Language

Click View on the menu bar and deselect “Auto connect” on

the drop-down menu that appears. Select the matched device and ports from the device list at

the left side of the page. Then click and hold Cabinet button -:l and drag it into editing
area, and you can click on the editing area repeatedly to add more cabinets. Select all the
cabinets and choose a cabinet connection type from the tool bar, then cabinets on the editing
area will be connected based on the connection type you choose.

Note:

After the cabinets on the editing area are connected manually, it is needed to choose and edit

cabinet connection type again if new cabinets are added.

www.novastar.tech 15
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o conrection

Mo cannection

Mo connection

Mo connection

Mo connection

Mo conrection

Ma conrection

IMa cannection

Mo cannection

o canrection

o canrection

Mo conrection

Mo conrection

Mo cannection

Add cabinets

Mo connection

Mo conrection

Mo conrection

Select cabinets

Delete Lines

www.novastar.tech
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'/
Select the cabinets among which the lines will be deleted, and click on Delete lines button

to disconnect the cabinets.

5.2.3 Screen Properties

Click on the blank of the screen and Properties of the screen will be shown on the right side of
the page.

Properties include grid color, grid spacing, disable edit.

Grid color: Click on the icon ‘— ] on the right side to select and edit grid color.
Grid spacing: One grid spacing is 10 pixels (within 1~500).

Froperties

Grid color
Grid spacing

Dizahle Edit

5.2.4 Loads of Ethernet Ports

You can view the loads of each Ethernet port at the bottom of editing area: Blue denotes that
the load is normal and the detailed information can be shown. Red denotes the load is

exceeded.

www.novastar.tech 17
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5.3 Hot Backup

¢
Click on Hot backup button on the right side of toolbar to access the page of hot backup.
=)

Het backup

Port name A1 + T &

Primary S0 Card Primary Part Backup 5D Card Backup Port

Cancel

Click the drop-down menu on the right side of Port name and select the port you want to back
up on the page of Hot backup.

Port name

Primary 5D G442

Click on Add button on the page of Hot backup to access the page of Add.
G Add =

Prirmary 80D Card 1 Backup 8D Card 1

Primary Port | Backup Port

5.4 Send

Click on the tool bar and it will prompt you “Do you want to match device?”

www.novastar.tech 18
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Cancel

Choose “Yes” and select matched online device on “Online devices”.

Match device

Online devices
Unknowen
Unknown

USB@Port #0010.Hub_ #0001

Cancel

Choose “No’” and do not send.

www.novastar.tech
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6 Online Operation

6.1 Creating Projects

Connect LED display controller to the PC used currently. Run the software. Refresh device list to

show device model and screen size.

SmartLCT V3.0 SmartLCT V3.0

Function Function

Create offline design Recent Create offline design R,
’ . Project srox ) ) Projectstox
[ Create online design [ Create online design
Project2.srex Projectz stox
Open Open
€  Language &  Language
Device list Fo) W] b Device list a0~
) ] ! .
O Bt O Bt USB@Port #0010.Hub_#0001 VK4S Lsets
Screen list & v Screen list (g
Screenl 314521

Create new projects of LED display configuration in online state. Click Create online design to
access the page of Create a new project.
Create a new project @

1. Name the project

ninistratorCocuments

Management

Manufacturer | Default

Type | Def:

ize

Cahinet columns 1

Function

Create offline design

[+ Create online design E i E il 5 t1 E Il
Open

&% Language

O Bt Norrnal o o]

1) Customize the project name and select the save path of the project.
2) Select the cabinet: Select LED display cabinet manufacturer and type.

www.novastar.tech 20
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3) Screen size: Set the number of columns and rows of cabinets.
4) Connection type: Choose the way to connect the cabinets.

6.1.1 Cabinet Management (See Cabinet Management in offline state)
6.1.2View Switching (See View Switching in offline state)

6.2 LED Display Configuration

Access the page of LED display configuration after new projects are created. Devices on the left

are online, as shown in the figure below.

6.2.1 Device List

Create projects or click existing projects to access the page of LED display configuration. Device
list is on the left side of the page.

Device

1
Port #0010.Hub_ #0001

Click the device to expand Ethernet port list and use the mouse to drag the scrollbar to view all
the ports.

Device Properties

Select a cabinet from editing area and the properties of the cabinet are shown on property area.
See details in Device List in offline state.

www.novastar.tech 21
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" FProperies

Manufacturer Default

Type Cefault

Device

Fart name LISB@FPort_ #0010 Hub_#0001

Test patterns

Adjust Color of LED Display

Move on to “Color” tab to adjust brightness and Gamma of LED display. It allows you to
customize color temperature(R, G and B brightness). Select “Synchronize” to adjust R, G and B
brightness synchronously.

Synchronize

Source Mapping
Move on to “Source mapping” tab to view mapping position of current device (the position of
the first added cabinet on LED display) and resolution of the video source of current device.

Sadrce mapping

Mapping X 0

Resolution W 720

Click “Advanced” to access advanced settings page of mapping of the selected device. Adjust
mapping position to change cabinet position on the screen.

Click the drop-down box at the right side of “Background” and you can choose “Default”,
“Grids” or “Pictures” as background.(The added background is applied on advanced settings

www.novastar.tech 22
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page only, and not shown on LED display.)

(@ Source mapping - [B =
& a ’

6.2.2 Cabinet Configuration (See Cabinet Configuration in Offline State)
6.2.3 Screen Properties (See Screen Properties in Offline State)

6.3 Seam Brightness Adjustment

It is required to complete the configuration (refers to adding cabinets and connect them) on the
page of LED display configuration. Click Operation>Fast Adjust Seam Data>Seam Brightness
Adjustment to access the page of Seam Brightness Adjustment. As shown in the figure below,
here we take VX4S as an example.

The number of cabinets on the page of Seam Brightness Adjustment is the same as the number
on the page of LED display configuration.

www.novastar.tech 23
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LED Details

SelectAll

I Default Selected
Valued Selected and Valued

Selected Area Parameters Adjustment

0.805

1.000 & Advanced

1.200

Buttons at the bottom right corner of the page include:

* Send: For sending seam brightness information to sending cards.

* Save: For saving current seam brightness information.

6.3.1 Area Splitting

Click the iconEon tool bar and the page of Area Splitting appears. Set the number of rows
and columns after a cabinet is split, then click OK to see the result.

Note: The number of rows and columns after a cabinet is split defaults to 5.

Area Splitting
Riow

Column

Cancel

www.novastar.tech
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6.3.2 Cabinet Restoring
Click the iconnon tool bar to restore the spilt cabinet to original state.

6.3.3 Selection

Selection includes “Select row and column”, “Column selection” and “Row selection”.

Click the icon.on tool bar, then click and drag your mouse to select cabinets and all the

borderlines of the cabinets are selected, as shown in the figure(left) below.

Click the icon-on tool bar, then click and drag your mouse to select cabinets and only
horizontal borderlines of the cabinets are selected, as shown in the figure(middle) below.

Click the icon-on tool bar, then click and drag your mouse to select cabinets and only vertical

borderlines of the cabinets are selected, as shown in the figure(right) below.

6.3.4LED Details

Click on the borders of any cabinets and LED details will appear on the right side of the screen.
Details of LEDs on the right border of Cabinet4 are shown as the figure below.

LED Details

Select some of the LEDs, click and drag the slider on the right side of “Selected Area Parameters
Adjustment” to adjust the parameter (defaults to 1.000). The selected area will be shown on the
border of the cabinet.

www.novastar.tech 25
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Gray There is no adjustable value if | Blue There is no adjustable value
not selected. if selected.

Light green | There are adjustable valuesif | Dark green | There are adjustable values
not selected. if selected.

6.3.5Display Window Modes

Click the buttonmon tool bar to switch display window mode (free switch between normal
mode and expanded mode).

Show/Hide Display Number

Click the buttonon tool bar to show cabinet numbers on display window. Click the button
again to hide the numbers.

Seamn Bright

Screent

1 2 &
= B T
49 10 11

Display Window Background

12

Screent

Click the buttonon tool bar to choose the background color of display window.

www.novastar.tech
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l:l [ Ja EH ~

[ ] Fullred

S Screent
B Fuil gree
[ | Full blue

B Fuil it

6.3.6 Deleting
Click the buttonnon tool bar to deselect the borderlines of all the cabinets.

4
Click the buttonon tool bar and a dialog box pops up to conform “Has the set data been
deleted completely?” Choose Yes to restore the interface to original state.

Tip

@ Has the set data been deleted completely?

6.4 Restoring Seam Data

After completing the configuration (refers to adding cabinets and connect them) on the page of
LED display configuration. Click Operation>Fast Adjust Seam Data> Restore Seam Data to
access the page of Restore Seam Data, as shown in the figure below.

SeamAdjust File  |CiUsersiddministrator/Deskiop/d56.53]

Select Screen  |Screen 1

Restore

www.novastar.tech 27
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Click on the icon . at the right side of “Seam Adjust File” to view and choose a path to save

the file. After the file is loaded successfully, click Restore to restore the seam data which is
adjusted before. Click Undo to cancel the operation to restore seam data.

6.5 Hot Backup

¢
Click Hot backup buttonat the top right corner of the tool bar to access the page of Hot
backup.

Hot backup @

Portname USB@Port_#0010.Hub_#0001 + W A

Primary $D Card Primary Port Backup $D Card Backup Port

Cancel

Click Add buttonto access the page of adding backup.
63 4dd (==

Primary Card i Y Backup S

Primary Port § = Backup Port

6.6 Sending

Click the buttonon tool bar to send LED display configuration information to corresponding
device.
If the loading capacity of Ethernet ports is exceeded, it will conform “It exceeds the loading

capacity. Sure to continue?”
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7 V-Sender

Devices supported by V-Sender includes MCTRL300(MSD300), MCTRL660/600,
MCTRL4K, VX4S, NovaPro HD, 3D HD.
When different devices are added, the interface of V-Sender will change according to different

functions of the devices. Here we take VX4S as an example.

7.1 How to Access V-Sender?

I.  Click the button as show in the figure below behind Device list on the stare page of

SmartLCT to access V-Sender.

Device list U ¥
USB@Port #0010.HUb_ #0001 WX4S5 lsets

[I. Asshown in the figure below, click the button on the page of LED display configuration to
enter V-Sender.

7.2 Menu Bar/Tool Bar

Menu Bar/Tool Bar Icon Function

Reconnect Device Connect the device again.

Device

Refresh Refresh device data.
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Add Device / Add new devices.
Firmware Upgrade / Upgrade the hardware program of devices.
Settings
Self-Test / Set screen test patterns.

Switch Ul language between Chinese and English

language | | (If the Ul language of SmartLCT is changed, the

guag language of V-Sender will be also switched at the

same time )

7.3 Adding Devices

® (lick Device>Add Devices on the menu bar.

= Add Device
® (lickon

Click Add Device and the page of Add Device appears, select the device you want to add and

at the bottom of device list.

click OK, then the new device is added to the page.

Add Device

Part Mame L] Humber

USB@FPort_#0010 Hub_#0001 WH4E 1

7.4 Device Information

® Enter V-Sender and allow you to view device model, Ethernet port and the number of
cascaded devices in device list.
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Device

MCTREED
Comi

Counts

MC TR& 603
NC TEE60—4

MCTRE&0-5

Count3

Count3

=+ Add Device

® After the device is added successfully, the picture and function introduction of the device
will be displayed on the Overview page of editing area, as shown in the figure below.

Overview

2,

LEED Display. Video Controlier

VX4S
Product Type : Video Controller
Inputs : HDMI, DVI, VGA* 2, CVBS x 2, DP, SDI

Capacity : 2.35 million pixels ; the maximum pixel CLK is 165MHz
Outputs : Ethernet port x 4

Supportimage mosaic. crop setting and PIP

The “Information” bar under the editing area includes “Supported Screen Size”, “Ethernet
Port Status.

Ethernet port status: “backed up& not connected”, “backed up& connected”, “not backed
up & not connected”, “not backed up& connected”, “Backup takes effect.”

. denotes that the port is primary port and connected to receiving cards.

. denotes that the port is primary port and not connected to receiving cards.

denotes that the port is backup port and connected to receiving cards.
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. denotes that the port is backup port and not connected to receiving cards.

- denotes that the backup port is being used for signal output now. (It indicates that
cable of this output channel is disconnected.)
Note:

The items of device information displayed are different while adding different devices, for example,
if a Novar HD unit is added, the information includes “Temperature” and “Voltage”. The figure

below shows the device information of NovaPro HD.

Part 1 Part 2 ; Port 4 Port 5 Y] Farte

7.5 Device Attributes

7.5.1 Attributes

You can see the attributes of the device on the right side of the page (here taking VX4S for
example). It allows you to view device name, port name, ID and firmware version.

W Aftribute

Mame

Patt Mame LI ort_#0010.Hub_F0001

1.600
Version 1.6.0.0

0.0 SmarlcT Debutg

Viarsion 1.6.0.0

0.0 SmartLCT Debuc

Font

juageFonty1.5.0.0
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7.5.2Input Signal Settings

Move on to “Input” tab and users can set Source Type and Data Bits.

* Source types: DVI, DP and HDMI.

* Input source data bits are based on source types. Data bits of different source types are
different. Data bits of source types including DVI, DP and HDMI are 8.

* You can use the preset values as “Resolution” and “Refresh Rate” in EDID or customize, as

shown in the figure below.

IRt

Source Type | DV

[Ciata Bits

ECID

Preset Custormize

Resolution | 1920%1030
EDID

Customize

Refresh Rate H 1080 (4

7.5.3 Output Signal Settings

Montage

When pixels of the LED display exceeds the loading capacity, montage needs to be enabled. The
total pixels of all cascaded devices should be the same as the pixels of the LED display.
Montage: “Equal Division” and “Non-Equal Division”. See detailed introduction in the chapter
Montage.

Note:

When a device is used for montage, “Disable Zoom” and “Custom Zoom” are unavailable and only
“Auto Fit to Screen” is available.

Main Screen

Enable or disable main screen and set the zoom mode of main screen.

Zoom modes include “Disable Zoom”, “Custom Zoom” and “Auto Fit to Screen”. See details in
the chapter PIP.

Minor Screen

Enable or disable minor screen and set the size and start position of minor screen as well as the
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size of position of the picture captured. The picture captured will be displayed on the LED
display.
Video Source Synchronization

Keep video source input and output of the device in sync.
Note: Video Source Synchronization is not available when montage is enabled.

7.5.4 Color Settings

You can control the color of LED display by adjusting the parameters of “Contrast”,
“Saturation”, “Hue” and “Sharpness”. Click and the sliders of corresponding parameters to
adjust the values. Click Apply to save your settings.

Calar

Caontrast

Saturation

Hue

7.5.5 System Settings

“LCD Lock”: Lock the LCD of the connected device. It cannot be operated after its LCD is locked.
“Smart Gray Scale”: Control LED display.

“Deinterlance”: Convert interlaced video signal to progressive signal.

“Genlock”: Synchronize read-only parameters.

“VGA Auto Processing”: Adjust the sampling parameters of VGA input signal automatically and
make the pictures distinct and complete.

“ADC Auto Calibration”: It may cause color cast or dim pictures without ADC calibration.
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System

Effects Switching | Close

LCD Lock

Smart Gray Scale

Switching

Deinterlace

LD Lock

ADC Auto Calibration

7.5.6 Audio Settings

* Set whether to output the audio signal;
* There are two audio types including “HDMI Audio” and “External Audio”;
* Adjust the volume by clicking and dragging the slider at the right side of Volume.

Audio

+/ Enahle Audio Output

Type  |HDMIAudio Type | HDOMIAudio

HOml Audio
ol WiDIL
External Audino

7.6 Main Functions

7.6.1PIP

Switch to PIP in the editing area to enter the PIP setting page. Click different icons in the toolbar
to adjust the layout status of the main screen and the minor screen, as shown in the following
figure.

Note:

Move the mouse to the editing area, and click and drag the mouse to change the size of both the

main screen and the minor screen.
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Main and Minor

Screens Switching

Switch between the main screen and the minor

Toolbar Icon Function
Cancel . Cancel the last operation.
Revert . Revert the last operation.

Zoomin n Zoom in the screen.

Zoom out H Zoom out the screen.

screen.

Horizontal Layout

As shown in the picture

Vertical Layout

As shown in the picture
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In the Middle As shown in the picture

Upper Left Layout As shown in the picture

Lower Left Layout As shown in the picture

Upper Right Layout As shown in the picture

oooo0

Lower Right Layout As shown in the picture

Main Screen Settings

Set the main screen’s scaling status including “Disable Zoom”, “Custom Zoom”, and “Auto Fit
to Screen”.

“Disable Zoom”: indicates to output images with the original proportion of the input images,

only the image offset position can be adjusted.

Main Screen

Disahle Zoom Custom Zoom Auto Fit To Screen

Screen Offzet
Size W
Position

Apply to All

“Custom Zoom”’: sets the starting position of the cut image which will be displayed on the screen;
“Size”: indicates the size of the current main screen displayed in the editing area; ‘“Position”:
indicates the starting position of the main screen displayed in the editing area.

hain Screen
Dizable Zoom Customn Zoom Auto Fit To Screen

cut W 720

‘ositian
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“Auto Fit to Screen”: Input contents are completely scaled to the screen body size,

automatically fitting the screen size. This mode is suitable for full-screen display of the display

contents.

Main Screen

Custom Zoom Auto Fit To Screen

Apply to All

After setting, click Apply to send the current configuration information to the signal source.
Minor Screen Settings

Tick “Cut” to edit the minor screen’s size and starting position, and the cut image will be
displayed on the screen.

" Minar Screen

W Cut

Faos

Fosition

Tran

After setting, click Apply to send the current configuration information to the signal source.

7.6.2Self-Test

Choose Settings, Self-Test to enter the self-test page.

Test Type includes “Color”, “Gradient”, “Grid”, and “Positioning”.
Test Pattern: There are various image types for different test types.

Customize test parameters including “Brightness”, “Spacing”, and “Speed” to make the image

have different test results.
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Self-Test

TestTwpe | Color

Test Pattern

Bright

Spacing
Test Type | Colar
Caolar
TestPatlem | gragient
: 2 . Grid
ormmal Displ 0 Cancel Brightne
Fositioning

After the test, click Normal Display at the bottom of the page to restore the screen to the
factory settings.

7.6.3 Display Control

Switch to Control page at the bottom of the editing area. Freely choose the signal source of
both the main screen, the minor screen, and the screen status.

The screen status includes “Black Out”, “Freeze”, and “Normal”’.

“Black Out”: does not display.

“Freeze”: freezes the current displayed contents.

“Normal”: normally displays the contents coming from the input source.

Main Screen ! CWBSZ n] =] HDmI

Minor Screen WIGAT ! . CWYHS C ? DF HOm

[t
=
=
=

Black Cut

Following figure is the signal source conflict list (VX4S):

Input Source of the Main Channel

HDMI DVI VGA1 VGA2 CVBS1 CVBS2 SDI DP
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HDMI - » v v v v v v

DVI x
VGA1 %
PIP
VGA2 v
Input
CVBS1 Vv
Source
CVBS2  V
SDI v
DP v
7.6.4 Montage
Click Output, Montage in the right attribute area of V-Sender page to enter the montage setting
page.

Montage function is required when the screen pixel numbers exceed the loading capacity of a

single device. Sum of all the cascading device loading areas is the total number of the screen

pixel (taking VX4S as an example).

* “Non-Equal Division”: Each VX4S loads different areas. Total number of the screen, loading
area of each VX4S, and starting position of the loading area are required to be set;

* “Equal Division”: Loading area of each VX4S is the same, and just set the total number of
the screen, row and column number, and the loading area of this VX4S.

After parameter setting, click Apply to send the parameter-set to hardware.

Output Qutput

+  Montage + Montage
MNon-Equal Division Egual Division Mon-Equal Divigion Equal Division
Total Width(Hy 128 Taotal Height() 128 TotalWidth(H) 128 Total Height(v) 123

Mosaic Rows 0 -

Mosaic Columns 0

Current Device Load Area Parameters

Location Load Position 0
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7.6.5 Template Settings
Switch to Template page at the bottom of the editing area. Save the current configured
parameters as templates, of which default number is 10, to be directly loaded next time.

Template

* (lickicon to save the current configured parameters as templates with the to be
selected template optional.

Template Template1

Termnplatel
Termnplate?
Template3

Save to Template
Termnplated
Templates
Template Template1
Templatet
Termnplate?
Termnplates
Template?d

Cancel

Termnplate10

e (lickicon E to delete the selected template.

Select the template data to be deleted

Template Template1

Cancel
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